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BDMS - Dokumentacija za krajnjeg korisnika

Sadr�aj

Vrh dokumenta

Ulazak

Raspored menija 

Dosije > Bud�etski Podaci > Rashodi - Obrazac

Dosije > Bud�etski Podaci > Rashodi - Osoblje

Dosije > Bud�etski Podaci > Rashodi - Izvori finans iranja

Dosije > Bud�etski Podaci > Rashodi - Ekonomske Kat egorije

Dosije > Bud�etski Podaci > Prihodi

Dosije > Bud�etski Podaci > Programi

Dosije > Bud�etski Podaci > Konsolodacija - Obrazac

Dosije > Bud�etski Podaci > Konsolidacija - Kontrol a

Dosije > Bud�etski Podaci > Konsolidacija - Osoblje

Dosije > Bud�etski Podaci > Konsolidacija - Izvori Finansiranja

Dosije > Bud�etski Podaci > Konsolidacija - Ekonoms ke kategorije

Dosije > Inicijalizacija > Plafon > Osoblje

Dosije > Inicijalizacijia > Plafon > Finansiranje

Dosije > Inicijalizacijia > Plafon > Data objekat

Dosije > Inicijalizacijia > Plafon > Prihodi

Dosjie > Inicijalizacija > Istorija > Rashodi

Dosije > Inicijalizacija > Istorija > Prihodi

Dosije > Inicijalizacija > Istorija > Programi

File > Save (Dosije > Sa� uvaj)

File > Print (Dosije > Štampaj)

File > Exit (Dosije > Izlaz)

Edit (Redigovanje)

Query (Pitanje)

Toolbar 

Osnovni Podaci > Region

Osnovni podaci > Opština/komuna

Osnovni podaci > Klasifikacija Osoblja

Osnovni Podaci > Koeficijenat Osoblja

Osnovni Podaci > Socijalna Sigurnost 

Osnovni podaci > Definicija Obrasca

Osnovni Podaci > Jezik

Osnovni Podaci > Prevod

Dijagrami Ra� una > Nivoi > Izvori Finansiranja

Dijagrami Ra� una > Nivoi > Bud�etska Organizacija

Dijagrami Ra� una > Nivoi > Funkcija

Dijagrami Ra� una > Nivoi > Ekonomska Kategorija

Dijagrami Ra� una > Nivoi > Generalni Program

Dijagrami Ra� una > Izvori Finansiranja

Dijagrami Ra� una > Bud�etska Organizacija

Dijagrami Ra� una > Funkcija

Dijagrami Ra� una > Ekonomske Kategorije

Dijagrami Ra� una > Generalni Program

Dijagrami Ra� una > Diagram Ra� una

Istorija > Osoblje

Istorija > Finansiranje

Istorija > Data objekat

Istorija > Prihodi 

Istorija > Klasifikacija Osoblja

Istorija > Stopa koeficijenta

Istorija > Socijalna sigurnost

Reports

Prozor (Window)

Pomo�  > Tipke (Help > Keys)

Pomo�  > Prika�i grešku (Help > Display Error)
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Draft, March 26, 2004

BDMS Kosovo (Sistem za Menad�ment Razvoja Bud�eta)

Dokumentacija za krajnjeg korisnika

Ulazak

Kada korisnik ulazi u BDMS, on/ona se mora upisati u prozor predvi� en za to (slika gore). On/ona mora
upisati korisni� ko ime, šifru, a zatim odabrati jezik i radnu godinu.

Kada bezbednosni sistem prihvati verifikacione informacije unete od strane korisnika, on ulazi u BDMS.
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Raspored menija

Za pristup instrukcijama “kliknite” na (samo podvu� ene) ulazne menije:

Pošto se korisnik uspešno uloguje u sistem, korisnik mo�e raditi u BDMS-u koriste � i sistem prema slede� em
meniju:

File (Dosije)    
 Bud�etski Podaci   
  Rashodi  
  Prihodi  
  Programi  
  Konsolodacija  
 Inicijalizacija   
  Plafon  
   Osoblje 
   Finansiranje 
   Data objekat
   Prihodi 
   ….
  Istorija  
   Rashodi
   Prihodi 
   Programi
   …..
 Štampaj   
 Izlaz   
Edit  (Redigovanje)    
 Cut (Preseci)   
 Paste (Prilepi)   
 Editor   
 Field   
  Clear (O� isti)  
  Duplicate (Dupliciraj)  
 Record (Ubeleška)   
  Insert (Umetnuti)  
  Delete (Obriši)  
  Copy record (Kopiraj Ubelešku)  
Query  (Pitanje)    
 Enter query (Uneti pitanje)   
 Execute query (Izvrši pitanje)   
 Cancel query (Otka�i Pitanje)   
Base Data  (Osnovni Podaci)    
 Region   
 Opština/komuna   
 Klasifikacija Osoblja   
 Koeficijenat Osoblja   
 Socijalna Sigurnost   
 Definicija Obrasca   
 Language (Jezik)   
 Prevod   
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Chart of Accounts  (Dijagrami Ra� una)    
 Nivoi   
  Izvori Finansiranja  
  Bud�etska Organizacija  
  Funkcija  
  Ekonomska Kategorija  
  Generalni Program  
 Izvori Finansiranja   
 Bud�etska Organizacija   
 Funkcija   
 Ekonomska Kategorija   
 Generalni Program   
 Dijagram Ra� una   
History  (Istorija)    
 Osoblje   
 Finansiranje   
 Data objekat   
 Prihodi    
 Klasifikacija Osoblja   
 Stopa koeficijenta   
 Socijalna sigurnost   
Reports  (Izveštaj)    
 Raspored 1 - Tabela A   
 Raspored 1 - Tabela B   
 Raspored 1 - Tabela C   
 Rashodi po funkciji   
 Prihodi   
 Generalni programi   

Rashodi po Funkciji (nivoi 1 i 2)
Window  (Prozor)    
 Kaskada   
 Razvuci po horizontali   
 Razvuci po vertikali   
Help (Pomo� )    
 Tipke   
 Prika�i grešku   
 U vezi sa…   
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Dosije > Bud�etski Podaci > Rashodi - Obrazac

Svrha:

Ova forma slu�i za pristup informacijama sa obrasci ma koštanja programa (u daljem tekstu PCF).

Glavne karakteristike ovog "prozora" su: 

Informacije su organizovane po tabelarnim stranama "Formulari", "Osoblje", "Izvori Finansiranja",
"Ekonomske Kategorije", koje su objašnjene u daljem tekstu.
Glavna strana "Obrasci" slu�i za odre � ivanje "Osnovnu godinu" za koju � e se bud�et pripremiti,
"Organizacije bud�eta" i PCF obrasca.

� im se gore navedeni podaci odrede korisnik � e ve�  imati dostupnu prvu verziju bud�eta sa podacima ko ji
dolaze iz sistema blagajne, tamo gde je to mogu� e.

Svaka verzija mo�e biti radna verzija (ozna � eno sa W) i/ili finalna verzija (ozna� eno sa F).

Pošto se odredi verzija, korisnik mo�e pristupiti d rugim tabelarnim stranama. 
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Dosije > Bud�etski Podaci > Rashodi - Osoblje

Svrha:

Kada korisnik odredi (selektira ili kreira) verziju za bud�etsku organizaciju on mo�e prilagoditi ili uneti novu
vrednost  u "�utoj" kolumni (osoblje).

Vrednosti u kolumni obele�enoj "sivom" bojom se ne mogu promeniti.

Rezimirane vrednosti u zadnjem redu se automatski izra� unavaju iz sistema.

Pritiskom (klikom na) dugme “Izveštaj” proizveš� e se (na novoj strani) izveštaj o troškovima programa po
kategorji osoblje, u formi prigodnoj za štampanje (u PDF formatu)
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Dosije > Bud�etski Podaci > Rashodi - Izvori finans iranja

Svrha:

Kada korisnik odredi (selektira ili kreira) verziju za bud�etsku organizaciju on mo�e prilagoditi ili uneti novu
vrednost  u "�utoj" kolumni na osnovu redova za izv ore finasiranja.

Vrednosti u kolumni obele�enoj "sivom" bojom se ne mogu promeniti.

Rezimirane vrednosti u zadnjem redu se automatski izra� unavaju iz sistema kada korisnik pritisne dugme
"izra� unaj vrednosti" (calculate values). 

Pressing (clicking on) "REPORT" button will produce (in a new page) a printable report of program cost form
by funding source (in PDF format). 
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Dosije > Bud�etski Podaci > Rashodi - Ekonomske Kat egorije

Svrha:

Kada korisnik odredi (selektira ili kreira) verziju za bud�etsku organizaciju on mo�e prilagoditi ili uneti novu
vrednost  u "�utoj" kolumni na osnovu redova za men ad�ment objekta.

Vrednosti u kolumni obele�enoj "sivom" bojom se ne mogu promeniti.

Rezimirane vrednosti u zadnjem redu se automatski izra� unavaju iz sistema kada korisnik pritisne dugme
"izra� unaj vrednosti".

Pritiskom (klikom na) dugme “Izveštaj” proizveš� e se (na novoj strani) izveštaj o troškovima programa po
ekonomskoj kategoriji, u formi prigodnoj za štampanje (u PDF formatu)
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Dosije > Bud�etski Podaci > Prihodi

Svrha:

Kada korisnik odredi (selektira ili kreira) verziju za bud�etsku organizaciju on mo�e prilagoditi ili uneti novu
vrednost  u "�utoj" kolumni na osnovu redova za eko nomske kategorije & naziv objekta.

Vrednosti u kolumni obele�enoj "sivom" bojom se ne mogu promeniti.

Rezimirane vrednosti u zadnjem redu se automatski izra� unavaju iz sistema.
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Dosije > Bud�etski Podaci > Programi

Svrha:

Ovaj "prozor" slu�i za prikaz podataka o razli � itim programima dostupnim u sistemu.

Prvo treba izabrati "osnovnu godinu" zatim nivo programa kao i sam program pa � e sistem u drugom delu
ekrana prikazati bud�etski iznos i potrošnju za bud �etske organizacije kao i izvore finansiranja.

Vrednosti u kolumni obele�enoj "sivom" bojom se ne mogu promeniti.

Rezimirane vrednosti u zadnjem redu se automatski izra� unavaju iz sistema kada korisnik pritisne dugme
"izra� unaj vrednosti".
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Dosije > Bud�etski Podaci > Konsolodacija - Obrazac

Svrha:

Ovaj "prozor"slu�i za konsolidaciju podataka unešen ih za bud�etsku pod-organizaciju koja predstavlja
direktan unos. Korisnik mora izabrati osnovnu godinu, bud�etsku organizaciju koja ne predstavlja direk tni
unos (sistem � e ih automatski filtrirati) kao i  PCF. Ne bi trebalo da postoji bilo kakva verzija za ove bud�etske
organizacije. Verzija � e se kreirati iz konsolidacionih procedura slede� e tabelarne stranice.
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Dosije > Bud�etski Podaci > Konsolidacija - Kontrol a

Svrha:

Ovaj � e prozor slu�iti za sinteti � ku kontrolu podataka unešenih za bud�etsku organiza ciju selektiranu u
prethodnoj tabelarnoj strani i selektiranu pod-bud� etsku organizaciju. Za svaku bud�etsku organizaciju
dobijamo informacije o obrascima koštanja programa, verzijie i to one finalne i informacije o osoblju izvorima
finansiranja, i data objektu.

Ukoliko postoji finalna verzija za svaku pod-bud�et sku organizaciju i informacija o osoblju, izvorima
finansiranja i data objektu (respektivna polja su ozna� ena) onda � e, pritiskom na dugme "konsolidiraj"
("conslolidate") podaci biti konsolidovani za odabranu glavnu bud�etsku organizaciju i novu verzijiu a  isto tako
� e i finalna biti kreirana.
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Dosije > Bud�etski Podaci > Konsolidacija - Osoblje

Svrha:

Ovaj � e "prozor" slu�iti samo za prikaz ve �  postoje� ih podataka. Podaci se ne mogu promeniti. 
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Dosije > Bud�etski Podaci > Konsolidacija - Izvori Finansiranja

Svrha:

Ovaj � e "prozor" slu�iti samo za prikaz ve �  postoje� ih podataka. Podaci se ne mogu promeniti.
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Dosije > Bud�etski Podaci > Konsolidacija - Ekonoms ke kategorije

Svrha:

Ovaj prozor slu�i samo za uvid u podatke. Podaci se  ne mogu promeniti.
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Dosije > Inicijalizacija > Plafon > Osoblje

Polja:

Staff code - Kodna 
oznaka osoblja

Kod (kodna oznaka) i opis osoblja. 

Budget organization -
Bud�etska
organizacija

Bud�etska organizacija kojoj selektirano osoblje pr ipada.

Year - Godina Vrednost godine. 
Staff ceiling - Plafon 
osoblja

Maksimalni broj osoblja (plafon) za selektirano osoblje, bud�etsku organizaciju i
godinu

Annual ceiling -
Godišnji plafon

Iznos godišnjeg plafona rashoda osoblja za selektiranu bud�etsku organizaciju,
osoblje  i godinu.  

Language - Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake,
naslovi, stavke iz menija, sadr�aj bivaju prevedeni  na selektirani jezik. Posle promene
jezika softver � e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za prikaz svih vrednosti prema go dini za koju je odre� en plafon.  

Tokom pripreme bud�eta ove maksimalne (plafon) vred nosti predstavljaju granicu do koje se mo�e i � i pri
pripremi bud�eta.

Pritiskom (klikom na) dugme “Izveštaj” proizveš� e se izveštaj o “plafonu” u smislu broja osoblja i iznosima za
osoblje i to prema kodnoj oznaci osoblja, bud�etsko j organizaciji i godini (u PDF formatu).
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Dosije > Inicijalizacijia > Plafon > Finansiranje

Polja:

Source of funds - 
Izvor finansiranja 

Kod (kodna oznaka) i opis izvora finansiranja 

Budget organization -
Bud�etska
organizacija

Bud�etska organizacija kojoj selektirani izvor fina nsiranja pripada

Year - Godina Vrednost godine. 
Annual ceiling -
Godišnji plafon 

Iznos godišnjeg plafona finansiranja za selektiranu bud�etsku organizaciju, osoblje  i
godinu. 

Language - Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake,
naslovi, stavke iz menija, sadr�aj bivaju prevedeni  na selektirani jezik. Posle promene
jezika softver � e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za prikaz svih vrednosti prema go dini za koju je odre� en plafon.  

Tokom pripreme bud�eta ove maksimalne (plafon) vred nosti predstavljaju granicu do koje se mo�e i � i pri
pripremi bud�eta.

Pritiskom (klikom na) dugme “Izveštaj” proizveš� e se izveštaj o “plafonu” u smislu broja osoblja i iznosima za
osoblje i to prema kodnoj oznaci osoblja, bud�etsko j organizaciji i godini (u PDF formatu)
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Dosije > Inicijalizacijia > Plafon > Data objekat

Polja:

Economic categories -
Ekonomske kategorije

Kod (kodna oznaka) i opis ekonomskih kategorija

Budget organization -
Bud�etska
organizacija

Bud�etska organizacija kojoj selektirani izvor fina nsiranja pripada

Year - Godina Vrednost godine 
Annual ceiling -
Godišnji plafon

Iznos godišnjeg plafona finansiranja za selektiranu ekonomsku kategoriju bud�etsku
organizaciju i godinu. 

Language - Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake,
naslovi, stavke iz menija, sadr�aj bivaju prevedeni  na selektirani jezik. Posle promene
jezika softver � e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za prikaz svih vrednosti prema go dini za koju je odre� en plafon.

Tokom pripreme bud�eta ove maksimalne (plafon) vred nosti predstavljaju granicu do koje se mo�e i � i pri
pripremi bud�eta.

Pritiskom (klikom na) dugme “Izveštaj” proizveš� e se izveštaj o ekonomskoj kategoriji u smislu “plafona”
godišnjeg iznosa i to prema bud�etskoj organizaciji  i godini (u PDF formatu)
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Dosije > Inicijalizacijia > Plafon > Prihodi

Polja:

Economic categories -
Ekonomska kategorija

Kod (kodna oznaka) i opis ekonomske kategorije.

Budget orgenization -
Bud�etska
organizacija

Bud�etska organizacija kojoj selektirani izvor fina nsiranja pripada.

Year - Godina Vrednost godine. 
Annual ceiling -
Godišnji plafon

Iznos godišnjeg plafona finansiranja za selektiranu ekonomsku kategoriju, bud�etsku
organizaciju i godinu. 

Language - Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake,
naslovi, stavke iz menija, sadr�aj bivaju prevedeni  na selektirani jezik. Posle promene
jezika softver � e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za prikaz svih vrednosti prema go dini za koju je odre� en plafon.  

Tokom pripreme bud�eta ove maksimalne (plafon) vred nosti predstavljaju granicu do koje se mo�e i � i pri
pripremi bud�eta.

Pritiskom (klikom na) dugme “Izveštaj” proizveš� e se izveštaj o ekonomskoj kategoriji u smislu “plafona”
godišnjeg iznosa i to prema bud�etskoj organizaciji  i godini (u PDF formatu)
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Dosijie > Inicijalizacija > Istorija > Rashodi

Svrha:

Gore prikazani prozor � e slu�iti za inicijalizaciju prve verzije rashoda z a bud�etsku godinu. Zna � i, umesto
zapo� injanja pripreme bud�eta od "nule"korisnik � e imati po� etne vrednosti koje dolaze iz istorije budzetskih
rashoda teku� e godine iz sistema blagajne. 

Korisnik mora odabrati obrazac a zatim mora odabrati bud�etsku organizacije za koju � e korisnik imati
inicijalizaciju a da bi završio zapo� eti proces korisnik mora pritisnuti dugme "iniciraj" (initialize).  
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Dosije > Inicijalizacija > Istorija > Prihodi

Svrha:

Gornji "prozor" � e slu�iti za inicijalizaciju prve verzije prihoda z a bud�etsku godinu. Zna � i, umesto
zapo� injanja pripreme bud�eta od nule, korisnik � e imati po� etne vrednosti koje dolaze iz istorije bud�etskih
prihoda teku� e godine iz sistema blagajne.  

Korisnik mora odabrati obrazac a zatim mora odabrati bud�etsku organizacije za koju � e korisnik imati
inicijalizaciju a da bi završio zapo� eti proces korisnik mora pritisnuti dugme "iniciraj" (initialize).  
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Dosije > Inicijalizacija > Istorija > Programi

Svrha:

Gornji "prozor" � e slu�iti za inicijalizaciju prve verzije programa za bud�etsku godinu. Zna � i, umesto
zapo� injanja pripreme bud�eta od nule, korisnik � e imati po� etne vrednosti koje dolaze iz istorije programskih
iznosa teku� e godine iz sistema blagajni.  

Korisnik mora odabrati obrazac a zatim mora odabrati bud�etsku organizacije za koju � e korisnik imati
inicijalizaciju a da bi završio zapo� eti proces korisnik mora pritisnuti dugme "iniciraj" (initialize).  
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File > Save (Dosije > Sa � uvaj)

Svrha:

Kada korisnik pritisne  "Sa� uvaj" svi unosi, a�uriranja i sva brisanja (kada su  dostupna prema privilegijama
korisnika) se predaju u BDMS server.   

File > Print (Dosije > Štampaj)

Svrha:

Ovo je standardna karakteristika "windows" operativnog sistema. Kada korisnik pritisne "Print" (štampaj) iz
menija, gore prikazani prozor se otvara a na njemu se mogu selektirati i promeniti razli� ite postavke prozora.  

File > Exit (Dosije > Izlaz)

Kada izabere  "Izlaz" (Exit) iz menija, korisnik izlazi iz softvera i zatvara konekciju sa BDMS serverom.
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Edit (Redigovanje)

Svrha:

Cut - Preseci Ovaj meni slu�i za komandu "preseci" u celom softveru.
Paste - Prilepi Ovaj meni slu�i za komandu "prilepi " u celom softveru.
Editor Ova stavka u meniju slu�i za otvaranje edito ra sistema za polje na kome se nalazi kursor  
Clear - O� isti Ovaj slu�i da "o � isti" sadr�aj polja.
Duplicate - 
Dupliciraj 

Ova stavka iz menija slu�i da kreira novu ubelešku ali kopira samo sadr�aj polja na kome
se nalazi kursor. 

Svrha:

Record > Insert / Ubeleška > Umetnuti Ova stavka iz menija slu�i za "umetanje" nove ubeleške u svim
"prozorima" (window).

Record > Delete /  Ubeleška > Obriši Ova stavka iz menija slu�i za "brisanje" ubeleške u svim
"prozorima" (window).

Record > Copy Record / Ubeleška >
Kopiraj Ubelešku

Ova stavka iz menija slu�i za "kopiranje" ubeleške u svim
"prozorima" (window).
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Query (Pitanje)

Svrha:

Enter Query / Uneti 
pitanje 

Ova stavka iz menija slu�i za ulazak u modalitet za  "pitanja" u svim "prozorima"
(window).

Execute Query /
Izvrši pitanje

Ova stavka iz menija slu�i za izvršavanje "pitanja"  u svim "prozorima" (window) pošto
ga je korisnik uneo u modalitetu za "pitanja".

Cancel Query /
Otka�i Pitanje

Ova stavka iz menija slu�i za otkazivanje modalitet a za pitanja u svim "prozorima"
(window) onda kada je korisnik prethodno ušao u taj modalitet. 
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Toolbar (Linija sa alatima)

Gore navedene akcije u meniju edit i pitanja se tako� e mogu izvesti i pre� icama u liniji sa alatima:

Ikonice u liniji sa alatima su:

  Umetnuti novu ubelešku u ulaznom obrascu1.

  Obrisati ubelešku u obrascu2.

  Duplicirati ubelešku u ulaznom obrascu3.

  Sa� uvati novu ubelešku u ulaznom obrascu4.

  Zapo� eti proces štampanja5.

  Startovati pitanje u ulaznom obrascu. Kada se jednom unese kriterijum pitanja dobijamo rezultate
pitanja u obrascu putem ponovnog pritiskanja iste ikonice .

6.

  Otkazati pitanje  u ulaznim obrascima7.

  Otvoriti sistemski editor radi zapo� injanja redigovanja dosijea8.

  Pokazati informaciju o proizvodu 9.

  Iza� i iz softverske aplikacije10.
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Osnovni Podaci > Region

Polja:

Code / Kod 
(kodna oznaka) 

Kodna oznaka regiona numeri� kog tipa. 

Tag / Navod Ime regiona tekstualnog tipa. 
Dt of creation / 
Datum kreiranja 

Datum kreiranja registracije u formatu DD.MM.GGGG koji pokazuje datum kojeg je
kregistracije kreirana. 

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi bio validan. 
Language / Jezik Mo�e se promeniti selektiranjem u b ox-listi. Kada se promeni jezik sve oznake, naslovi,

stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za unos kodova i imena regiona.
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Osnovni podaci > Opština/komuna

Polja:

Region Ovo polje slu�i za flitriranje opština prema  regionu.
Code / Kodna 
oznaka 

Kodna oznaka opštine numeri� kog tipa.

Commune /
Opština

Ime opštine tekstualnog tipa.

Dt of creation / 
Datum kreiranja  

Datum kreiranja registracije u formatu DD.MM.GGGG koji pokazuje datum kojeg je
kregistracije kreirana 

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi bio validan. 
Mo�e se promeniti selektiranjem u box-listi. Kada s e promeni jezik sve oznake, naslovi,
stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika
softver � e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ova prozor slu�i za unos i filtriranje kodova i ime na opština u zavisnosti od regiona.  
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Osnovni podaci > Klasifikacija Osoblja

Polja:

Code / Kodna 
oznaka 

Kodna oznaka za klasifikaciju osoblja numeri� kog tipa.

Coef1 / Koef1 Koeficijent za klasifikaciju osoblja, numeri� kog tipa
Tag / Navod Opis klasifikacije osoblja, tekstualnog tipa 
Date until / 
Datum do  

Datum do kojeg je koeficijient u desnoj kolumni bio validan u formatu DD.MM.GGGG koji
pokazuje datum kada je registracija kreirana

Coef2 / Koef2 Istorijska vrednost koeficijenta osoblja prema datumu do kojeg su bili validni.  
Language / 
Jezik 

Mo�e se promeniti selektiranjem u box-listi. Kada s e promeni jezik sve oznake, naslovi, stavke
iz menija, sadr�aj bivaju prevedeni na selektirani jezik. Posle promene jezika softver � e ostati
u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za unos kodova, vrednosti koefici jenta i opisa za klasifikaciju osoblja.
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Osnovni Podaci > Koeficijenat Osoblja

Polja:

Code / Kodna
oznaka 

Kodna oznaka za isplatu osoblja numeri� kog tipa.

Rate1 / 
Stopa1 

Koeficijent za isplatu osoblja, numeri� kog tipa

Date until / 
Datum do

Datum do kojeg je stopa u desnoj kolumni bila validna u formatu DD.MM.GGGG koji pokazuje
datum kada je registracija kreirana. 

Rate2 / 
Stopa2

Istorijska vrednost stopa prema datumu do kojeg su bile validne.  

Language / 
Jezik 

Mo�e se promeniti selektiranjem u box-listi. Kada s e promeni jezik sve oznake, naslovi, stavke
iz menija, sadr�aj bivaju prevedeni na selektirani jezik. Posle promene jezika softver � e ostati
u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za unos stopa za isplatu radnika.
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Osnovni Podaci > Socijalna Sigurnost 

Polja:

Code / Kodna 
oznaka 

Kodna oznakab registracije socijalnog i zdravstvenog osiguranja ispla� enog od strane
zaposlenog i poslodavca. 

Soc ins employee
/ Soc. Osig.
Zaposlenog 

Koeficijent socijalnog osiguranja, numeri� kog tipa u procentima pla� enog od strane
zaposlenog.

Soc ins employer 
/ Soc. Osig.
Poslodavca 

Koeficijent socijalnog osiguranja, numeri� kog tipa u procentima pla� enog od strane
poslodavca.

Health ins 
employee / Zdrav.
Osig. Zaposlenog

Koeficijent zdravstvenog osiguranja, numeri� kog tipa u procentima pla� enog od strane
zaposlenog.

Health ins 
employer / Zdrav.
Osig. Poslodavca

Koeficijent zdravstvenog osiguranja, numeri� kog tipa u procentima pla� enog od strane
poslodavca.

Date until / Datum 
do 

Datum do kojeg je stopa u desnoj kolumni bila validna u formatu DD.MM.GGGG koji
pokazuje datum kada je registracija kreirana. 

Soc ins employee
/ Soc. Osig.
Zaposlenog 

Istorijiske vrednosti socijalnog osiguranja pla� enog od strane zaposlenog do datuma do
kojeg su bili validne.

Soc ins employer 
/ Soc. Osig.
Poslodavca 

Istorijiske vrednosti socijalnog osiguranja pla� enog od strane poslodavca do datuma do
kojeg su bili validne 

Health ins 
employee / Zdrav.
Osig. Zaposlenog

Istorijiske vrednosti zdravstvenog osiguranja pla� enog od strane zaposlenog do datuma do
kojeg su bili validne.

Health ins 
employer / Zdrav.
Osig. Poslodavca

Istorijiske vrednosti zdravstvenog osiguranja pla� enog od strane poslodavca do datuma do
kojeg su bili validne. 

Language / Jezik Mo�e se promeniti selektiranjem u box-listi. Kada s e promeni jezik sve oznake, naslovi,
stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za unos stope za socijalni i zdra vstveni doprinos i za pokazivanje istorijske vrednosti stope.  
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Osnovni podaci > Definicija Obrasca

Polja:

Form no / Broj
Obrasca 

Broj koji treba uzeti u obzir za obrazac koštanja programa, npr. za PCF vrednost bi trebala biti
3. 

Code / Kodna 
oznaka 

Kodna oznaka za obrazac koštanja programa, npr PCF3.

Tag / Navod Opis obrasca koštanja programa.
Language / 
Jezik 

Mo�e se promeniti selektiranjem u box-listi. Kada s e promeni jezik sve oznake, naslovi,
stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za odr�avanje definicija za obras ce koštanja programa.
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Osnovni Podaci > Jezik

Polja:

Code / Kodna
oznaka 

Kodna oznaka jezika. 

Tag / Navod Ime (opis) jezika. 
Language / 
Jezik 

Mo�e se promeniti selektiranjem u box-listi. Kada s e promeni jezik sve oznake, naslovi, stavke
iz menija, sadr�aj bivaju prevedeni na selektirani jezik. Posle promene jezika softver � e ostati
u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za odr�avanje definicija jezika n a kojim je sistem u stanju da radi.  
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Osnovni Podaci > Prevod

Polja:

Form name / Ime obrasca Ime obrasca kao dosijea u sistemu. 
Description / Opis Opis svrhe za koju se obrazac koristi. 
Object name / Ime objekta Ime objekta u obrascu koji se treba prevesti. 
Object type / Tip objekta Tip objekta u obrascu. 
Language / Jezik Jezik na kojem � e se izvesti prevod.
Translation / Prevod Prevod imena objekta u selektiranom jeziku 

Svrha:

Modalitet prevoda se koristi za prevod vidljivih navoda, natpisa, standardnih poruka, naslova prozora itd, kroz
celi modalitet korisnika BDMS (obrasca).

U gornjem delu ekrana pitanja administratora za ime modaliteta (Ime Obrasca).

U donjem delu ekrana prikazani su objekti i njihovi prevodi u relevantnom jeziku.

Za prevod objekata u novo-dodanom jeziku, u� inite slede� e korake: 

Kliknite na objekat koji �elite prevesti
Kreirajte novu praznu ubelešku pritiskom na dugme "Kreiraj Ubelešku" (Create Record), prvom
dugmetu na paleti za "alate" (toolbar)
Tada iskoristite dugme za dupliciranje "duplicate" (tre� e dugme na paleti za alate) tako da se
informacije u novo-kreiranim ubeleškama dupliciraju iz prethodne ubeleške.
Tada iz otvorene liste dostupnih jezika selektirati novi jezik a zatim u polje za prevod uneti odgovaraju� i
prevedeni tekst.
Sve sa� uvajte pritiskom na digme "sa� uvaj" (save) locirano na paleti za "alate".
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Dijagrami Ra � una > Nivoi > Izvori Finansiranja

Prvi Deo 

Polja:

Level no / Broj 
nivoa 

Kodna oznaka nivoa. 

Tag / Navodi Opis za koji je u� injen unos.
Display length /
Prika�i du�inu 

Broj simbola � e biti prikazan u zavisnosti od nivoa.

Dt created / 
Datum Kreiranja 

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG.

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi bio validan. 
Language / Jezik Mo�e se promeniti selektiranjem u b ox-listi. Kada se promeni jezik sve oznake, naslovi,

stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Prvi deo � e se korisititi za manipulaciju (umetnuti, izbrisati, a�urirati) unosa u sistem. 
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Drugi Deo

Polja:

Level no / Broj nivoa Kodna oznaka nivoa. 
Tag / Navodi Opis za koji je u� injen unos.
Display length / Prika�i
du�inu

Broj simbola � e biti prikazan u zavisnosti od nivoa.

Dt of creation / Datum 
Kreiranja

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG.

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi
bio validan. 

Svrha:

Drugi deo � e se koristiti samo da prika�e unose u tabelarnom f ormatu.
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Dijagrami Ra � una > Nivoi > Bud�etska Organizacija

Prvi Deo

Polja:

Level no / Broj 
nivoa

Kodna oznaka nivoa. 

Tag / Navodi Opis za koji je u� injen unos.
Dsp length /
Prika�i du�inu

Broj simbola � e biti prikazan u zavisnosti od nivoa.

Dt of creation / 
Datum Kreiranja

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG.

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi bio validan. 
Language / Jezik Mo�e se promeniti selektiranjem u b ox-listi. Kada se promeni jezik sve oznake, naslovi,

stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Prvi deo � e se korisititi za manipulaciju (umetnuti, izbrisati, a�urirati) unosa u sistem.
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Drugi Deo

Polja: 

Level no / Broj nivoa Kodna oznaka nivoa. 
Tag / Navodi Opis za koji je u� injen unos.
Dsp length / Prika�i du�inu Opis za koji je u � injen unos.
Dt of creation / Datum 
Kreiranja

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG.

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi
bio validan. 

Svrha:

Drugi deo � e se koristiti samo da prika�e unose u tabelarnom f ormatu.  
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Dijiagrami Ra � una > Nivoi > Funkcija

Prvi Deo 

Polja:

Level / Broj 
nivoa

Kodna oznaka nivoa. 

Tag / Navodi Opis za koji je u� injen unos.
Dsp length /
Prika�i du�inu

Broj simbola � e biti prikazan u zavisnosti od nivoa.

Dt of creation / 
Datum Kreiranja

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG.

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi bio validan.
Language / Jezik Mo�e se promeniti selektiranjem u b ox-listi. Kada se promeni jezik sve oznake, naslovi,

stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Prvi deo � e se korisititi za manipulaciju (umetnuti, izbrisati, a�urirati) unosa u sistem.
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Drugi Deo

Polja:

Level / Broj nivoa Kodna oznaka nivoa. 
Tag / Navodi Opis za koji je u� injen unos.
Dsp length / Prika�i du�inu Broj simbola � e biti prikazan u zavisnosti od nivoa.
Dt of creation / Datum 
Kreiranja 

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG.

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi
bio validan. 

Svrha:

Drugi deo � e se koristiti samo da prika�e unose u tabelarnom f ormatu.  
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Dijagram Ra � una > Nivoi > Ekonomska Kategorija

Prvi Deo 

Polja:

Level / Broj 
nivoa

Kodna oznaka nivoa. 

Tag / Navodi Opis za koji je u� injen unos.
Dsp length /
Prika�i du�inu

Broj simbola � e biti prikazan u zavisnosti od nivoa.

Dt of creation / 
Datum Kreiranja 

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG. 
Status   

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi bio validan.
Language / Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake, naslovi,

stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Prvi deo � e se korisititi za manipulaciju (umetnuti, izbrisati, a�urirati) unosa u sistem.
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Drugi Deo

Polja:  

Level / Broj nivoa Kodna oznaka nivoa.
Tag / Navodi Opis za koji je u� injen unos.
Dsp length / Prika�i du�inu Broj of the characters � e biti prikazan prema nivou.
Dt of creation / Datum
Kreiranja

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG.

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi
bio validan.

Svrha:

Drugi deo � e se koristiti samo da prika�e unose u tabelarnom f ormatu.
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Dijagram Ra � una > Nivoi > Generalni Program

Prvi Deo

Polja:  

Level / Broj nivoa Kodna oznaka nivoa.
Tag / Navodi Opis za koji je u� injen unos.
Dsp length /
Prika�i du�inu

Broj simbola � e biti prikazan u zavisnosti od nivoa.

Dt of creation /
Datum Kreiranja

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG.

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi bio validan.
Language / Jezik Mo�e se promeniti selektiranje u bo x-listi. Kada se promeni jezik sve oznake, naslovi,

stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Prvi deo � e se korisititi za manipulaciju (umetnuti, izbrisati, a�urirati) unosa u sistem.
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Drugi Deo

Polja:

Level / Broj nivoa Kodna oznaka nivoa. 
Tag / Navodi Opis za koji je u� injen unos.
Dsp length / Prika�i du�inu Broj simbola � e biti prikazan u zavisnosti od nivoa.
Dt of creation / Datum 
Kreiranja 

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG.

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi
bio validan.

Svrha:

Drugi deo � e se koristiti samo da prika�e unose u tabelarnom f ormatu.
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Dijagram Ra � una > Izvori Finansiranja

Prvi Deo

Na desnoj strani su prikazani kodovi i opis po hijerarhiji u formi razgranatog drveta .

Svrha:

Svrha je prikaz svih unosa na hijerarhijski na� in.
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Drugi Deo

Polja:

Level / Nivo Pokazuje nivo ubeleške selektirane iz "razgranatnog drveta"
Superior code / 
Superiorna kodna 
oznaka 

Superiorna kodna oznaka odabrane ubeleške.

SoF code / SoF 
kodna ozn. 

Kodna oznaka unosa selektiranog na desnoj strani "razgranatog" drveta.

Tag / Navodi Opis unosa selektiranog na desnoj strani "razgranatog drveta".
Dt of creation / 
Datum Kreiranja

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG.

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi bio
validan. 

Izveštaj Kada se pritisne ovo dugme otvara se izveštaj za sve bud�etske organizacije u
tabelarnom formatu, koji se potom mo�e štampati ili  prevesti u druge formate kao što je
PDF.

Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake, naslovi,
stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika
softver � e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Za svaki unos selektiran na desnom razgranatom drvetu pokazani su detalji u desnom prozoru.

Sve manipulacije (uneti, obrisati, a�urirati) ubele ške su u� injene na desnom prozoru. 
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Dijagram Ra � una > Bud�etska Organizacija

Prvi Deo 

Na desnoj strani su prikazani kodovi i opis po hijerarhiji u formi razgranatog drveta.

Svrha:

Svrha je prikaz svih unosa na hijerarhijski na� in.
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Drugi Deo

Polja:

Broj nivoa Pokazuje nivo ubeleške selektirane na "razgranatom drvetu".
Superiorni Superiorni kod selektirane ubeleške.
Kodna oznaka Kodna oznakaunosa selektiranog na desnoj strani razgranatog drveta.
Navod Opis unosa selektiranog na desnom razgranatom drvetu.
Opština
(municipality)

Opština kojoj pripada selektirana  bud�etska organi zacija. 

Bud�etski
Specijalista

Bud�etski specijalista dodeljen selektiranoj bud�et skoj organizaciji

Direktor Bud�eta Direktor bud�etskog odeljenja za se lektiranu bud�etsku organizaciju. 
Finanasije 
Kontakt 

Finansijska kontakt osoba za selektiranu bud�etsku organizaciju

Glavni
Finansijski Slu�.

Glavni Finansijski Slu�benik za selektiranu bud�ets ku organizaciju. 

Slu�b. za
Sertifikaciiju

Slu�benik za Sertifikaciju za selektiranu bud�etsku  organizaciju. 

Telefon Broj kontakt telefona za selektiranu bud�et sku organizaciju 
Email Email adresa za selektiranu bud�etsku organiz aciju 
Datum kreiranja. Datum kada je kreirana ubeleška u formatu DD.MM.GGGG.
Direktni unos Vrednost koja kada se odabere pokazuje da selektirana bud�etska organizacija predstavlja

direktni unos podataka. Kada direktni unos niije obele�en to zna � i da se podaci bud�etske
organizacije trebaju uneti iz bud�etskog odeljenja u MEF

Status  Status unosa kada je ubele�en kao validan i na� e unos u sitemu više ne bi bio validan.
Izveštaj Kada se pritisne ovo dugme otvara se izveštaj za sve bud�etske organizacije u tabelarnom

formatu, koji se potom mo�e štampati ili prevesti u  druge formate kao što je PDF.
Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake, naslovi,

stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Za svaki unos selektiran na desnom razgranatom drvetu pokazani su detalji u desnom prozoru.

Sve manipulacije (umetnuti, izbrisati, a�urirati) u beleške su u� injene na desnom prozoru.
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Dijagrami Ra � una > Funkcija

Prvi deo 

Na desnoj strani su prikazani kodovi i opis po hijerarhiji u formi razgranatog drveta.

Svrha:

Svrha je prikaz svih unosa na hijerarhijski na� in.
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Drugi Deo

Polja:

Nivo Pokazuje nivo ubeleške selektirane iz "razgranatnong drveta"
Kodna oznaka Kodna oznaka unosa selektiranog na desnom "razgranatom drvetu"
Navodi Opis unonsa selektiranog nan desnoj strani "razgranatog drveta".
Superiorna 
kodna oznaka 

Superiorna kodna oznaka selektirane ubeleške

Datum 
Kreiranja 

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG.

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi bio validan. 
Izveštaj Kada se pritisne ovo dugme otvara se izveštaj za sve bud�etske organizacije u tabelarnom

formatu, koji se potom mo�e štampati ili prevesti u  druge formate kao što je PDF.
Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake, naslovi,

stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Za svaki unos selektiran na desnom razgranatom drvetu pokazani su detalji u desnom prozoru.

Sve manipulacije (umetnuti, izbrisati, a�urirati) u beleške su u� injene na desnom prozoru.
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Dijagram Ra � una > Ekonomske Kategorije

Prvi deo 

Na desnoj strani su prikazani kodovi i opis po hijerarhiji u formi razgranatog drveta.

Svrha:

Svrha je prikaz svih unosa na hijerarhijski na� in.
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Drugi Deo

Polja:

Broj Nivo Pokazuje nivo ubeleške selektirane iz "razgranatnong drveta"
Kodna 
oznaka 

Kodna oznaka unosa selektiranog na desnom "razgranatom drvetu".

Navodi Opis unonsa selektiranog nan desnoj strani "razgranatog drveta".
Superiorni Superiorni kod i opis selektirane ubeleške.
Rashodi Kada se odabere ovo polje ono pokazuje da je ekonomska kategorija tipa rashoda.
Prihodi Kada se odabere ovo polje ono pokazuje da je ekonomska kategorija tipa prihoda.
Datum
Kreiranja  

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG.

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi bio validan. 
Izveštaj Kada se pritisne ovo dugme otvara se izveštaj za sve bud�etske organizacije u tabelarnom

formatu, koji se potom mo�e štampati ili prevesti u  druge formate kao što je PDF.
Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake, naslovi, stavke

iz menija, sadr�aj bivaju prevedeni na selektirani jezik. Posle promene jezika softver � e ostati u
selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Za svaki unos selektiran na desnom razgranatom drvetu pokazani su detalji u desnom prozoru.

Sve manipulacije (umetnuti, izbrisati, a�urirati) u beleške su u� injene na desnom prozoru.
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Dijagram Ra � una > Generalni Program

Prvi deo

Na desnoj strani su prikazani kodovi i opis po hijerarhiji u formi razgranatog drveta.

Svrha:

Svrha je prikaz svih unosa na hijerarhijski na� in. 
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Drugi Deo

Polja:

Broj Nivoa Pokazuje nivo ubeleške selektirane iz "razgranatnong drveta"
Superiorni Superiorni kod i opis selektirane ubeleške
Kodna oznaka Kodna oznaka unosa selektiranog na desnom "razgranatom drvetu"
Navodi Opis unonsa selektiranog nan desnoj strani "razgranatog drveta".
Funkcija Funkcija selektiranog programa 
Kodna oznaka
blagajne 

Kodna oznaka blagajne za selektirani program. 

Region Regoin za selektirani program. 
Datum 
Kreiranja 

Datum kada � e se kreirati ubeleška u formatu DD.MM.GGGG.

Status Status unosa kada je ubele�en kao validan je r ina� e unos u sitemu više ne bi bio validan. 
Izveštaj Kada se pritisne ovo dugme otvara se izveštaj za sve bud�etske organizacije u tabelarnom

formatu, koji se potom mo�e štampati ili prevesti u  druge formate kao što je PDF.
Jezik Mo�e se promeniti selektiranje u box-listi. K ada se promeni jezik sve oznake, naslovi, stavke

iz menija, sadr�aj bivaju prevedeni na selektirani jezik. Posle promene jezika softver � e ostati
u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Za svaki unos selektiran na desnom razgranatom drvetu pokazani su detalji u desnom prozoru.

Sve manipulacije (umetnuti, izbrisati, a�urirati) u beleške su u� injene na desnom prozoru.
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Dijagram Ra � una > Diagram Ra � una

Polja:

Izvori 
finansiranja 

Za selektirani nivo mo�e se izabrati Izvor Finansir anja pritiskom na dugme i selektiranjem sa
liste vrednosti.

Budzetska 
Organizacija 

Za selektirani nivo mo�e se izabrati Bud�etska Orga nizacija pritiskom na dugme i
selektiranjem sa liste vrednosti.

Funkcija Za selektirani nivo mo�e se izabrati Funkc ija pritiskom na dugme i selektiranjem sa liste
vrednosti.

Ekonomske 
Kategorije 

Za selektirani nivo moge se izabrati Ekonomske Kategorijie pritiskom na dugme i
selektiranjem sa liste vrednosti. 

Programi Za selektirani nivo moge se izabrati Programi pritiskom na dugme i selektiranjem sa liste
vrednosti. 

Bud�etska linija Pokazuje bud�etsku liniju vrednosti  polja prethodno selektiranog kada se pritiske dugme
"generiši" (generate).

Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake, naslovi,
stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Svrha ovog prozora je da pokaze bud�etski liniiju z a svaku selekciju prema gore navedenim poljima.  
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Istorija > Osoblje

Polja:

Kodna oznaka 
osoblja 

Kodna oznaka i opis osoblja. 

Bud�etska
organizacija

Bud�etska organizacija kojoj selektirano osoblje pr ipada.

Godina Vrednost godine 
Godišnje
osoblje

Godišnji broj osoblja za selektirano osoblje, bud�e tsku organizaciju i godinu. 

Godišnji
rashodi 

Iznos godišnjih rashoda za selektirano osoblje, bud�etsku organizaciju i godinu.

Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake, naslovi,
stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za prikaz svih istorijskih vredno sti prema godini.

Pritiskom (klikom na) dugme “Izveštaj” proizveš� e se izveštaj o istoriji osoblja u smislu broja osoblja i iznosa
za osoblje i to prema kodnoj oznaci osoblja, bud�et skoj organizaciji i godini (u PDF formatu).
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Istorija > Finansiranje

Polja:

Izvor 
finansiranja 

kodna oznaka i opis izvora finansiranja. 

Bud�etska
organizacija

Bud�etska organizacija kojoj selektirani izvor fina nsiranja pripada.

Godina Vrednost godine. 
Godišnji ste� eni Godišnji ste� eni iznos za selektirane izvore finansiranja, bud�e tsku organizaciju i godinu. 
Godišnji
potrošeni

Godišnju potrošeni iznos za selektirane izvore finansiranja, bud�etsku organiiziaciju i godinu. 

Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake, naslovi,
stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za prikaz svih istorijskih vredno sti prema godini.

Pritiskom (klikom na) dugme “Izveštaj” proizveš� e se izveštaj o izvorima finansiranja u smislu godišnjih
prihoda i rashoda i to prema  bud�etskoj organizaci ji i godini (u PDF formatu)
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Istorija > Data objekat

Polja:

Ekonomska 
kategorija 

Kodna oznaka i opis ekonomske kategorije 

Bud�etska
organizacija

Bud�etska organizacija kojoj selektirana ekonomska kategorija pripada.

Godina Vrednost godine 
Godišnji
rashodi

Iznos godišnjih rashoda za selektiranu ekonomsku kategoriju, bud�etsku organiizaciju i
godinu

Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake, naslovi,
stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za prikaz svih istorijskih vredno sti prema godini.

Pritiskom (klikom na) dugme “Izveštaj” proizveš� e se izveštaj o ekonomskim kategorijama u smislu iznosa
godišnjih rashoda i to prema  bud�etskoj organizaci ji i godini (u PDF formatu).
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Istorija > Prihodi 

Polja:

Ekonomska 
kategorija 

Kodna oznaka i opis ekonomske kategorije 

Bud�etska
organizacija

Bud�etska organizacija kojoj selektirana ekonomska kategorija pripada

Godina Vrednost godine 
Godišnji prihodi Iznos godišnjih prihoda za selektiranu ekonomsku kategoriju, bud�etsku organizaciju i

godinu.
Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake, naslovi,

stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za prikaz svih istorijskih vredno sti prema godini.

Pritiskom (klikom na) dugme “Izveštaj” proizveš� e se izveštaj o ekonomskim kategorijama u smislu (u PDF
formatu).
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Istorija > Klasifikacija Osoblja

Polja:

Kodna 
oznaka 

Kodna oznaka za klasifikaciju osoblja, numeri� kog tipa.

Koef 1 Koeficijent sa klasifikaciju osoblja, numeri� kog tipa. 
Navodi Opis kalsifikacije osoblja, tekstualnog tipa. 
Datum do Datum do kojeg je koeficijent u desnoj kolumni bio validan u formatu DD.MM.GGGG koji pokazuje

datum daka je registracija kreirana
Koef  2 Istorijska vrednost koeficijenta osoblja prema datumu do kojeg su bili validni. 
Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake, naslovi, stavke iz

menija, sadr�aj bivaju prevedeni na selektirani jez ik. Posle promene jezika softver � e ostati u
selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za prikaz kodova, vrednosti koefi cijenta i opis za klasifiikaciiju osoblje.  
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Istorija > Stopa koeficijenta

Polja:

Kodna 
oznaka 

Kodna oznaka za stopu isplate osoblja, numeri� kog tipa. 

Stopa 1 Koeficijent za isplatu radnika, numeri� kog tipa.
Datum do Datum do kojeg je stopa u desnoj kolumni bila validna u formatu DD.MM.GGGG koji pokazuje

datum kada je registracija kreirana. 
Stopa 2 Istorijska vrednost stopa prema datumu do kojeg su bili validni. 
Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake, naslovi, stavke iz

menija, sadr�aj bivaju prevedeni na selektirani jez ik. Posle promene jezika softver � e ostati u
selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za unos stopa za isplatu radnika.
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Istorija > Socijalna sigurnost

Polja:

Kodna oznaka Kodna oznaka registracije socijalnog i zdravstvenog osiguranja ispla� enog od strane
zaposlenog i poslodavca. 

Soc. Osig. 
Zaposlenog 

Koeficijent socijalnog osiguranja, numeri� kog tipa u procentima, pla� enog od strane
zaposlenog

Soc. Osig. 
Poslodavca 

Koeficijent socijalnog osiguranja, numeri� kog tipa u procentima, pla� enog od strane
poslodavca

Zdrav.Osig. 
Zaposlenog 

Koeficijent zdravstvenog osiguranja, numeri� kog tipa u procentima, pla� enog od strane
zaposlenog

Zdrav. Osig. 
Poslodavca 

Koeficijent zdravstvenog osiguranja, numeri� kog tipa u procentima, pla� enog od strane
poslodavca

Datum do Datum do kojeg je stopa u desnoj kolumni bila validna u formatu DD.MM.GGGG koji
pokazuje datum kada je registracija kreirana 

Soc. Osig. 
Zaposlenog 

Istorijiske vrednosti socijalnog osiguranja pla� enog od strane zaposlenog do datuma do
kojeg su bili validne

Soc. Osig. 
Poslodavca 

Istorijiske vrednosti socijalnog osiguranja pla� enog od strane poslodavca do datuma do
kojeg su bili validne 

Zdrav. Osig. 
Zaposlenog 

Istorijiske vrednosti zdravstvenog osiguranja pla� enog od strane zaposlenog do datuma do
kojeg su bili validne

Zdrav. Osig. 
Poslodavca 

Istorijiske vrednosti zdravstvenog osiguranja pla� enog od strane poslodavca do datuma do
kojeg su bili validne 

Jezik Mo�e se promeniti selektiranjem u box-listi. Kada se promeni jezik sve oznake, naslovi,
stavke iz menija, sadr�aj bivaju prevedeni na selek tirani jezik. Posle promene jezika softver
� e ostati u selektiranom jeziku sve dok se jezik ponovo ne promeni.

Svrha:

Ovaj prozor slu�i za unos stope za socijalne i zdra vstvene stope doprinosa i prikaz istorijskih vrednosti stopa. 
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Izveštaji (Reports)

 

Na meniju “izveštaji” korisnik mo�e koristiti izveš taje za Generalni Bud�et Kosova 

Raspored 1_Tabela A 
Raspored 1_Tabela C 
Prihodi
Generalni Programi 
Rashodi po Funkciji (nivo 1 i 2) 

Gornji izveštaji se mogu koristiti iniciranjem menija izveštaja kao što je to prikazano na gornjoj
slici.

Prozor (Window)

Svrha:

Window "prozor" meni je isti kao i svaki drugi "window" meni u "windows" softverima

Kada se pritisne "kaskada" ("padaju� i prozor") svi otvoreni "prozori" se prikazuju u kaskadi. Kada se pritisne
"razvuci" svi otvoreni prozori se razvla� e a kada se odabere "arrange icons" (uredi ikone) sre� uju se ikone
ukoliko postoje.

Ukoliko postoji više od jednog prozora, mogu se selektirati pritiskom na naslov prozora.
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Pomo �  > Tipke (Help > Keys)

Svrha:

Kada se pritisne "tipke" (Keys) otvara se prozor koji pokazuje funkciju tipki u softveru.  

Pomo �  > Prika�i grešku (Help > Display Error)

Kada se javi greška, pritiskom na Prika�i Grešku, p oruka o grešci mo�e biti prikazana u "boksu" predvi � enom
za prikaz grešaka. 
Vrh dokumenta
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